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Welcome to the Photo CD Browser Help.

From this page you can get Help on how to use the Photo CD Browser.

Click on a button to make your choice.
          What is the Photo CD Browser?  
          Photo CD Browser window  
          How To...  
          Menus  
          Memory requirements  
          Using this Help  
          About GST  

To choose a Help option...

Point to your choice and click.

Use Tab or Shift Tab to highlight your choice, then press Return.

For more information about using Help, click on Using this Help above.



How To...
Click on a button for Help with using the Photo CD Browser.

          Send a photo to an application  
          Select a photo pack  
          View copyright information  
          Change the preview size  
          Change the export colour depth  
          Change the export resolution  
          Rotate/mirror a photo  
          Exit the Photo CD Browser  



Menus
Click on a button to see a list of menu commands.

          Browser menu  
          Image menu  
          Options menu  
          Help menu  



Browser menu
Browser menu
          Select Photo Pack  
          View Copyright  
          Exit  



Image menu
Image menu
          Normal  
          Rotate Left  
          Rotate Right  
          Mirror  



Options menu
Options menu
          Info Line  
          Always on Top  
          Preferences  



Help menu
Help menu
          Contents  
          About Browser  



The Photo CD Browser window
Click on an area of the Photo CD Browser window below to popup a description of the selected area.



Using this Help
Online Help is a convenient way to obtain information about using the Photo CD Browser.

You may like to print out the Help because the Photo CD Browser is not explained in any of GST's 
manuals. Printing Help is explained below.

You can keep the Help window permanently in view while you work by selecting Always on Top from 
the windows Help menu.

Moving around this Help
As in all Windows Help applications, you move around the Photo CD Browser's Help to areas of interest 
using a system of 'jumps'. You can also 'pop up' definitions of specific words and phrases.

Most other Help systems show jumps as green text underlined with solid or dotted lines. In this Help, 
jumps are shown as buttons, and popup definitions are indicated by underlined normal (black) text.

This button appears throughout the Help. It denotes a 'main' topic heading; another subject which
may be relevant to the one you are currently reading about; a dialog description; or more information of 
related interest. Click on the button, or on its title text, to 'jump' to its topic.

A definition is available for any underlined word or phrase. Click on the word(s) to 'pop up' the 
information.

Ways to choose a Help option...
To choose a Help topic, point to the button of the topic you want to read. The mouse pointer changes 
shape to a pointing finger. Click the left mouse button to jump to that Help topic.

Alternatively, you can press Tab or Shift Tab to highlight the button of your choice, then press Return to
display that Help topic.

Once the topic you want to read is displayed in the Help window, use the vertical scroll bar to move 
through the Help.

Searching for Help
You can quickly search the Help system for help on a specific subject. To do this

1. Click on the Search button in the Help window's button bar. The Search dialog will be displayed.

2. Scroll through the list of subjects and click on the one you would like to read about.

3. Click on the Show Topics button. A list of the topics associated with that subject will be 
displayed. Select a topic.

4. Click on the Go To button. The selected topic will be displayed in the Photo CD Browser Help 
window.

You can then scroll through the Help as described above.

Browsing and Backtracking
Use the Browse buttons (<< and >>) at the top of the Help window to browse backwards and forwards 
through the surrounding help topics. 
Click on the Back button in the Help window's button bar to backtrack a step at a time up the hierarchy 
of topics you have viewed in this Help session.

Click on the History button to display a list of the last 40 topics you have viewed in this Help session. 
Double-click on a topic to display it in the main Help window.

Printing Help
You can print the Help so that you have a hard copy to refer to. To print the current Help topic, select 



Print Topic from the File menu of the Help window. The current Help topic is printed to the currently 
selected printer.

To choose a different printer, or to change the default printer options, select Print Setup from the File 
menu of the Help window and choose the printer to which you want to print.

Note: You cannot print information that is in a 'pop up' window.

Cancelling Help
Select Close from the Help window's Control   menu  , or press Alt F4.



What is the Photo CD Browser ?
The Photo CD Browser is a utility that lets you search through and select photo images stored on a 
Photo CD.    The images can then be exported (as Windows™ bitmaps) to any application that accepts 
this file type.

The Photo CD Browser displays previews of the photos which are divided into photo packs.    The size 
and orientation of these photos can be manipulated, before you export them to your chosen application.

The Photo CD Browser will read disks of Photo CD Master format version 0.5 or later, and is designed to
read from Photo CD compatible CD ROMs and software drivers.    For more information refer to the 
documentation supplied with your CD ROM or contact your CD ROM dealer.



Memory requirements
Each time you export a photo a temporary bitmap file is created in your temporary directory. This file is 
overwritten each time you export another photo but it can be extremely large, depending on your export 
preferences.    For example with an export resolution of 2048x3072 and a colour depth of 16.7M colours,
the bitmap created is 18.9 Mbytes in size.    To export and display photos your system must have 
enough free RAM and disk space to accommodate the temporary bitmap file.    Therefore we 
recommend that your temporary directory is an area on your hard disk, not a RAMDrive.

If necessary you can change the location of your temporary directory using the MS-DOS SET command.
This should be done each time you want to use the Photo CD Browser and before you run Windows. 
For example the following command line sets the temporary directory to the \TEMP directory on drive C:

SET TEMP=C:\TEMP

Now any application, including the Photo CD Browser, that uses your temporary file area will place its 
temporary files in C:\TEMP. 

Alternatively you could modify the SET TEMP= line in your AUTOEXEC.BAT file to permanently change 
the location of the temporary directory. 

Note:
For further information about the SET command or editing your AUTOEXEC.BAT file, refer to your 
DOS manual.

The table below shows the approximate memory required by photos exported with each of the export 
resolutions at the various colour depths.

See also:
          How to send a photo to an application  



Browser menu: Select Photo Pack
Click on Select Photo Pack to search for and preview a photo pack. The Select Photo Pack dialog is 
displayed.

See also:
          How to select a photo pack  
          Select Photo Pack   dialog  



Browser menu: View Copyright
Select View Copyright to view the copyright information of the currently selected photo preview.    The 
View Copyright Information dialog is displayed.

See also:
          How to view copyright information  
          View Copyright Information   dialog  



Browser menu: Exit
Select Exit to close the Photo CD Browser. 

Keyboard shortcut:
Alt F4



Options menu: Info Line
Select Info Line to turn the information line on or off. The information line is divided into two sections: 
the left side displays hints on how to use the Photo CD Browser, the right side displays the number of 
your selected photo and information about your export preferences.

The command is ticked when the information line is shown.



Options menu: Always on Top
Select Always on Top to permanently display the Photo CD Browser in front of any other window on 
your desktop. This command is ticked when selected.



Options menu: Preferences
Select Preferences to control aspects of how the Photo CD Browser works. The Preferences dialog is 
displayed. You can control the size of the previews in the photo preview area and the resolution and 
colour depth of the exported photos.

Settings in the Preferences dialog are saved when you exit the Photo CD Browser.

See also:
          How to change the preview size  
          How to change the export colour depth  
          How to change the export resolution  
          Preferences   dialog  



Image menu: Normal
Select Normal to return the selected photo preview to it's original orientation after rotating and/or 
mirroring it using the Rotate Left, Rotate Right or Mirror commands.

Keyboard Shortcut:
Ctrl N

See also:
          Image menu: Rotate Left  
          Image menu: Rotate Right  
          Image menu: Mirror  
          Rotating/Mirroring a photo  



Image menu: Rotate Left
Select Rotate Left to rotate the selected photo preview through 90 degrees anticlockwise.    When you 
export the photo to an application, it will be rotated as the preview illustrates.    The original image on 
your Photo CD will not change.

Note:
By using a combination of Rotate Left, Rotate Right and Mirror, any orthogonal orientation of the 
photograph is possible.

Keyboard Shortcut:
Ctrl L

See also:
          Image menu: Normal  
          Image menu: Rotate Right  
          Image menu: Mirror  
          Rotating/Mirroring a photo  



Image menu: Rotate Right
Select Rotate Right to rotate the selected photo preview through 90 degrees clockwise.    When you 
export the photo to an application, it will be rotated as the preview illustrates.    The original image on 
your Photo CD will not change.

Note:
By using a combination of Rotate Left, Rotate Right and Mirror, any orthogonal orientation of the 
photograph is possible.

Keyboard Shortcut:
Ctrl R

See also:
          Image menu: Normal  
          Image menu: Rotate Left  
          Image menu: Mirror  
          Rotating/Mirroring a photo  



Image menu: Mirror
Select Mirror to mirror the selected photo preview over a vertical axis fixed down the centre of the 
photo.    When you export the photo to an application, it will be mirrored as the preview illustrates.    The 
original image on your Photo CD will not change.

Note:
By using a combination of Rotate Left, Rotate Right and Mirror, any orthogonal orientation of the 
photograph is possible.

Keyboard Shortcut:
Ctrl R

See also:
          Image menu: Normal  
          Image menu: Rotate Left  
          Image menu: Rotate Right  
          Rotating/Mirroring a photo  



Help menu: Contents
Select Contents to display the Contents page of the Photo CD Browser Help. From the Contents page 
you can choose which part of the Photo CD Browser you want Help on.

Keyboard Shortcut:
F1



Help menu: About Browser
Select About Browser to display the Photo CD Browser billboard. This shows the version number of 
your copy of the Photo CD Browser and a copyright notice.



Selecting a photo pack
The previews of the images on a Photo CD are divided into photo packs. You can select different photo 
packs from a particular Photo CD using the Select Photo Pack dialog.    You can preview only one 
photo pack at a time.

How to select a photo pack

1. Click on Select Photo Pack in the Browser menu.    The Select Photo Pack dialog is displayed.

2. From the Drives drop down list box select the drive you want to search for a photo pack.    The 
directories on this drive are displayed in the Directories box.

3. From the Directories box select the directory you want to search, then click on OK.

The Photo CD Browser will search your chosen drive and directory for a photo pack.    When a photo 
pack is found a dialog will be displayed asking if you want to load the previews it contains.    If no photo 
pack is found a message is displayed to inform you. Click OK to close the message box and select a 
new drive and/or directory.

Note:
You can cancel loading the previews by pressing Esc at any time during the loading process.

See also:
          How to send a photo to an application  
          How to change the preview size  
          How to change the export colour depth  
          How to change the export resolution  
          How to view the copyright information  
          Select Photo Pack   dialog  



Sending a photo to an application
How to select a photo

Click on a photo in the preview area to select it; the photo is highlighted when selected.

How to send a photo to an application

There are two ways to send a photo to an application.
By dragging and dropping.

1. Make sure the application to which you want to send the photo is running either as a window or 
as an icon.

2. Arrange the windows on your screen so that both the Photo CD Browser and the application 
window or icon are visible.

3. From the Photo CD Browser select the photo you want to export.

4. Hold down the left mouse button and "drag" the photo to the application window or icon.    The 
mouse pointer will change shape to a hand when it is over an application that will accept "drag 
and drop" items.

5. Release the mouse button to "drop" the photo into your chosen application.
By double-clicking and selecting the application to receive the photo.

1. Double-click on the photo you want to send or select the photo then press RETURN. The Send to
Application popup menu is displayed listing the applications currently running that can receive 
your photo.

2. Select the application you want to send the photo to. The popup menu disappears and the photo 
is sent to your chosen application.

Note:
You can cancel sending a photo to an application by pressing Esc.
The photo images can be sent to applications that will accept Windows bitmaps (.BMP) format.
When you send the photo to an application that places the photo in its own document window, for 
instance, an image enhancement application, the window is named as ~PHOTOnn.BMP, where nn is 
01 for the first photo sent in each session and increased by one for each of the following photos. If you 
want to keep a copy of the photo on your hard drive, you must use the destination application's Save 
As command to save the it in a directory other than the temporary directory.
This is because the Photo CD Browser erases the previous ~PHOTOnn.BMP file from the temporary 
directory when you send the next photo or exit the Photo CD Browser. If you do not save the photo 
before exiting the destination application it will no longer exist as a .BMP file in your temporary 
directory.

See also:
          How to select a photo pack  
          How to change the preview size  
          How to change the export colour depth  
          How to change the export resolution  
          How to view the copyright information  
          Memory requirements  



Changing the preview size
The Photo CD Browser can display previews in two sizes, large (128x192 pixels) and small (64x96 
pixels).    You can choose the size you want using the Preferences dialog.

How to change the preview size

1. Select Preferences from the Options menu. The Preferences dialog is displayed.

2. In the Preview Size box click on the size you want.

3. Click on OK.
Settings in the Preferences dialog are saved when you exit the Photo CD Browser.

Note:
The dimensions in the Preview Size box represent a portrait picture (greater in height than width).    
However if the photo you are previewing is a landscape photo (greater in width than height) the 
dimensions are swapped over accordingly.

See also:
          Preferences   dialog  



Changing the export colour depth
The Photo CD Browser can export photo images in a range of colour depths.

To change the export colour depth

1. Select Preferences from the Options menu. The Preferences dialog is displayed.

2. From the Export Colour drop down list box, select the depth of colour you want for your exported
photos.

3. Click on OK.
Settings in the Preferences dialog are saved when you exit the Photo CD Browser.

See also:
          How to send photos to an application  
          Preferences   dialog  



Changing the export resolution
The Photo CD Browser can export photo images in a range of resolutions.

To change the export resolution

1. Select Preferences from the Options menu. The Preferences dialog is displayed.

2. From the Export Resolution drop down list box, select the resolution you want for your exported 
photos.

3. Click on OK.
Settings in the Preferences dialog are saved when you exit the Photo CD Browser.

Note:
The dimensions of the export resolutions in the Export Resolution drop down list box all represent a 
portrait picture (greater in height than width).    However if the photo you are exporting is a landscape 
photo (greater in width than height) the dimensions are swapped over accordingly.

For example, if you export a landscape photo and choose an export resolution of 512 x 768 the photo 
image that appears in your application will have a resolution of 768 x 512.

See also:
          How to send photos to an application  
          Preferences   dialog  



Viewing copyright information
The photos on a Photo CD often have some copyright information associated with them.    The Photo 
CD Browser enables you to view this information.

To view copyright information

1 Select the photo whose copyright information you want to view.

2 Select View Copyright from the Browser menu. The Copyright Information dialog will be 
displayed containing the copyright information for the photo preview you have selected.
Use the vertical scroll bar at the side of the information window to scroll through the information.    
If there is no copyright information associated with the photo, a message will appear at the top of 
the dialog to inform you of this.

3. When you have read the information, click on OK to close the dialog.

Note:
The copyright information displayed in the Copyright Information dialog may not be complete or 
correct and should be treated as a guide for interest only.



Rotating/Mirroring a photo
How to rotate/mirror a photo

Select the photo you want to rotate/mirror.    Select Normal, Rotate Left, Rotate Right, or Mirror as 
appropriate from the Image menu.

Using a combination of the commands in the Image menu various orientations are possible.    For 
example the Mirror command alone reflects the picture over a vertical axis.    However, the following 
sequence will reflect the picture over a horizontal axis:

Mirror, Rotate Left, Rotate Left.

Shortcuts
Ctrl N, Ctrl L, Ctrl R, Ctrl M.

See also:
          Image menu: Normal  
          Image menu: Rotate Left  
          Image menu: Rotate Right  
          Image menu: Mirror  



Exiting the Photo CD Browser
How to exit the Photo CD Browser

Select Exit from the Browser menu or select Close from the Control menu.
You can also exit the Photo CD Browser by double-clicking on the Control-menu box.

Shortcut
Alt F4



About GST Software plc
European software publisher GST Software plc specialises in the development, marketing and 
licensing of desktop publishing and graphics software world wide for IBM PCs and compatibles.
Our product range includes these market leaders, all renowned for their powerful features, ease of use 
and outstanding value for money:

Designworks
Pressworks

1st Press
1st Design

GST software is distributed in the UK by Electric Distribution. For more information about any of GST's 
products, call Electric Distribution on 0480 496666, fax us on 0480 496189, or email us at: 
electric@gst-soft.demon.co.uk

Pressworks
Pressworks is GST's desktop publishing package for Windows. The program combines powerful 
desktop publishing features and ease of use at an affordable price.

Use Designworks as the ideal illustration partner to Pressworks to produce striking drawings, logos, 
letterheads and much more for Pressworks documents.

Designworks
Designworks is GST's drawing and illustration package for Windows. The program combines powerful 
drawing features and ease of use at an affordable price.

Use Designworks as the ideal partner to Pressworks to produce striking drawings, logos, letterheads 
and much more for your Pressworks documents.

GST Softline
GST offers full customer support for all its products via its Softline service. For a modest subscription, 
Softline members enjoy a range of benefits which include:

Access to the members-only hotline.
Priority service for problem solving.
Access to the Softline bulletin board.
Previews of forthcoming new products.
Discounts on program upgrades.
Special rates on training.

Telephone GST's Customer Services Dept. on 0480 496575 or send email to: customer@gst-
soft.demon.co.uk and we'll tell you how to join Softline.



GST Training Centres
GST Training Centres specialise in providing courses to help users get the most from their PC 
software. Effective, enjoyable and professional training is available on a broad range of software 
packages, including Designworks and Pressworks.

Call 0954 789908 for more details.



Preferences dialog
This dialog is displayed when you select Preferences from the Options menu.

From this dialog you can choose the size of the previews in the photo preview area and the resolution 
and colour depth of photos that you export.

Preview Size box

Provides options to change the size of previews displayed in the photo preview area.
Small (64 x 96 pixels): click on this box to display small photo previews.    If you choose small 

previews, more previews can be displayed, but their quality will be reduced
Large (128 x 192 pixels): click on this box to display large photo previews.

Export Colour drop down list box

Controls the colour depth of your exported photos.    Click on the arrow to the right of the box to drop 
down a list of the available colour depths.    Click on a colour depth to select it.

Export Resolution group box

Controls the resolution of your exported photos.    Click on the arrow to the right of the box to drop down 
a list of the available resolutions.    Click on a resolution to select it.

See also:
          How to change the preview size  
          How to change the export colour depth  
          How to change the export resolution  



Select Photo Pack dialog
This dialog is displayed when you click on Select Photo Pack from the Browser menu.

From this dialog you can choose the photo pack that you want to preview.

Directories group box

Lists the directories available on the selected drive.    Select the directory where the photo pack you 
want is located.

Drives drop down list box

Click on the arrow on the right of the box to drop down a list of the available drives.    Select the drive 
from which you want to load a photo pack.

See also:
          How to select a photo pack  



Copyright Information dialog
This dialog is displayed when you select a photo then select View Copyright from the Browser menu.

Use the vertical scroll bar at the side of the information window to scroll through the information.    If 
there is no copyright information associated with the photo, a message will appear at the top of the 
dialog to inform you of this.

See also:
          How to view copyright information  



Resolution
The dimensions of a picture or screen in units of pixels.    For example an export resolution of 256 x 384 
produces a picture 256 pixels wide and 384 pixels deep.



Colour depth
The maximum number of colours used in the reproduction, on screen or otherwise, of a photo.



Photo pack
Photos on a Photo CD are divided into groups each containing a number of photo previews;    these 
groups are called photo packs.    Only one photo pack can be viewed at a time.



Drive
The device from which information is loaded into your computer, eg. floppy disk drive, hard disk drive, 
CD ROM drive, etc.



Orthogonal
Related to some reference position by a rotation of 90, 180 or 270 degrees, or by a reflection over a 
horizontal or vertical axis.



Export
The technical term for sending a photo from the browser to another application.



Scroll bar
A bar that appears at the bottom and/or right side of a window whose contents are not entirely visible.



Control menu

 A standard Windows menu displayed by clicking on the Control-menu box at the top-left corner of a 
window, or clicking on an application running as an icon. By using Control menu commands you can, 
resize, move, maximize, minimize and close windows and switch to other applications.



Dialog
A window that is temporarily displayed to request information. When a dialog is displayed, all interaction 
with the Photo CD Browser must be through the dialog.



Preview
A reduced bitmap representation of a photo.



Menu bar
The horizontal bar containing the names of the Photo CD Browser's menus.    Click on a menu name to 
drop down a list of the corresponding commands.



Scroll bar
The horizontal bar that appears at the bottom of the Photo Preview Area when not all of the previews 
are visible.    Click on the arrows at either end of the scroll bar to see more previews.



 Control-menu box
Click on the Control-menu box    to display the Photo CD Browser Control menu. By using Control 
menu commands you can resize, move, maximize, minimize, and close windows, and switch to other 
applications.
Keyboard shortcut:
Alt Spacebar



 Minimize button
Click on the Minimize button to reduce the Photo CD Browser window to an icon.

When you reduce the Photo CD Browser to an icon, it continues to run but its window does not 
take up space on your desktop.



 Maximize button
Click on the Maximize button to enlarge the Photo CD Browser window to its maximum size.

After you enlarge the Photo CD Browser, the Maximize button is replaced by the Restore button, 
which contains both an up and a down arrow.    Click on the Restore button to return the Photo CD 
Browser window to its previous size.



Title bar
The title bar shows the name of the application, in this case, Photo CD Browser.

You can maximize the Photo CD Browser by double-clicking on its title bar.    To restore it to its 
previous size, double-click on the title bar again.

To move the Photo CD Browser to a different location on your desktop, drag its title bar to the 
new location.



Photo Preview Area
Displays previews of the photos in the selected photo pack.
Use the horizontal scroll bar below the photo preview area to view all the photos in the photo pack.



Information line: Hint line
Displays hints on what to do next in the Photo CD Browser window.



Information line: Export Resolution
Displays your selected export resolution.    The Export Resolution is selected in the Preferences 
dialog.



Information line: Export Colour Depth
Displays your selected export colour depth.    The Export Colour Depth is selected in the Preferences 
dialog.






